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Digital Stereoscope 

Owner's Manual (rev. 2.0) 

Congratulations for purchasing the Cyclopital3D digital 

stereoscope! As fellow stereo photography enthusiasts, we 

are excited to make this product available to you. Please 

contact us if you have any questions or problems with 

your Viewer as we are committed to providing you with 

the highest level of customer service and quality products. 

We appreciate your business! 

Viewer Package Includes: 

Viewer with 2 ViewSonic VPD400 Personal Media Players 

(PMPs) 

2 Chargers 

2 USB cables 

1 set of earphones 

1 Allen wrench/Hex wrench size .050 inch 

1 Extra control (unit as a backup) 

1 Microfiber lens cleaning cloth 

2 Disposable lens cleaning cloths for cleaning internal mirrors 

1 Manual 

Ken Burgess 

President, CEO  

kburess@cyclopital3d.com 

Tanya Alsip 

Vice President, CFO 

talsip@cyclopital3d.com 

 

Cyclopital3D 
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Viewer Features: 

• Bright stereoscopic images with no ghosting 

• Stunningly wide Field Of View (FOV) provides an ortho-stereo perspective 

for most digital stereo cameras – you see the same FOV as the camera 

• Stereoscopic zoom and pan 

• Holds thousands of stereo pairs on 16GB of combined memory 

• Completely portable, provides 4 hours of continuous viewing before 

recharging 

• Focus adjustment accommodates the vision of most people 

• Images can be organized into folders for rapid access 

• Fully coated precision optics with large, perfectly matched achromatic 

lenses provide a uniquely immersive viewing experience 

• High quality front surface mirrors provide crisp, bright and perfectly aligned 

images 
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Viewer Diagram Legend 

Note: Right and Left are referenced looking into the lenses. 

1. Left PMP power button, press for two seconds to power on 

2. Right PMP power button, press for two seconds to power on 

3. Left PMP “Up Arrow” (on top), use for correcting mis-sync condition 

4. Left PMP “Down Arrow” (on top), use for correcting mis-sync condition 

5. Focus knob, adjust for best focus 

6. Left PMP DC power-in port 

7. Right PMP DC power-in port 

8. Left PMP USB port 

9. Right PMP USB port 

10.Left PMP microSD card slot 

11.Right PMP microSD card slot 

12.RightPMP Volume control 

13.Right PMP Video out jack 

14.RightPMP Audio out / headphone 

15.Right PMP power switch (on bottom, MUST be ON to Use or Charge) 

16.Left PMP power switch (on bottom, MUST be ON to Use or Charge) 

17.Control panel, operates both PMP units simultaneously 

18.¼ – 20 Tripod mount, for tabletop tripod or handle (not supplied) 

19.Port for Kensington cable lock 

20.Left PMP mounting set screws (4-40) 

21.Left PMP mounting set screw (4-40) 

22.Right PMP mounting set screw (4-40) 

23.Right PMP mounting set screw (4-40) 

24.Handle, for picking the Viewer up off a table or out of a box 

 

The Control Panel: 

C1. Power button. Used to power off the PMP units (will not turn the units on) 

C2. >|| button. Used to start and stop slide shows and exit image zoom 

C3. +Vol. Used to turn the audio volume up, and to zoom in on images 

C4. –Vol. Used to turn the audio volume down, and to zoom out on images 

C5. Up-Arrow. Used to go “up” in menus and backwards when viewing images 

C6. Down-Arrow. Used to go “down” in menus and forwards when viewing 

images 

C7. Left-Arrow. Used to go “right” in menus and as an “escape” or “back” 

button 

C8. Right-Arrow. Used to go “left” in menus 

C9. “M” button. Used to “select” a function or as an “enter” button 
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Viewer Usage 

We thought you might be excited to view some images right away, so the 

Viewer is preloaded with a sample set of some of our favorite photos. To begin: 

1. Turn on power for PMP units by moving switches 15 & 16 into the “ON” 

position, then push and hold buttons 1 & 2 for two seconds. Look into 

eyepieces to see the menu light up to confirm that both units have powered 

up. Note: the Menu text will be reversed due to the Viewer’s Wheatstone 

design. 

2. Using the control panel on the bottom of the Viewer (17), press the right 

arrow (C8) to advance the menu to the photo (camera) icon. Then press the 

middle “M” button (C9) on the control panel to “select” the function. Note, if 

you accidentally select the wrong icon, the left arrow (C7) on the control 

panel acts as your “back” button. When you select the photo function you 

will see a menu of folders identifying which “Disk” to access. “Local Disk” 

is the memory built into the PMP unit; “External Disk” is the optional 

microSD card. Select “Local Disk” to see a folder named “Samples,” select it 

and you see a list of images, select again to view the image in 3D. 

3. When your images are on the screen use the focus knob on top (5) of the 

Viewer to find the best position for your clearest viewing. You may need to 

re-adjust the focus for images with subjects that are close up or far away. 

4. Advance images by firmly pressing the down-arrow button (C6) on the 

control panel, press the up-arrow (C5) to go backwards through the images. 

5. When you are done viewing turn off the Viewer using the power button (C1) 

on the control panel (17) or moving switches 15 and 16 into the off position. 

Notes: 

• Very important!! When charging the PMP units, the switches on the bottom 

of each unit (15 & 16) MUST be in the ON position. 

• The Viewer has a power save function that comes preset to turn the Viewer 

backlight off after 15 minutes of no activity, but it will drain power at a low 

level unless the PMP units are turned completely off. 

• It's possible for the two PMP units to become mis-synchronized when 

viewing images; there are a couple of reasons this can happen: either a button 

was accidentally pressed on the top of one PMP unit that advances the picture 

on that unit, but not the other, or the control pad wasn’t pressed firmly 

enough to send the infrared signal to both units. There are a few ways to 

recover from a mis-synchronized condition; see page 10 “Troubleshooting” 

for remedies. 

• The Cyclopital3D Stereoscope (Viewer) is based on the Wheatstone design 

of the 1830's which incorporates mirrors to provide a wide Field of View 

(FOV). As a result the Viewer uses independent left and right files that must 

be flipped horizontally (mirrored) for correct viewing. The images may also 

be re-centered or offset in order to obtain the widest HFOV and the most 

comfortable viewing. 
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Preparing Images for your Viewer using StereoPhotoMaker (SPM) 

Digital stereo photographs are composed of two images, one for the left eye 

and one for the right. They can be stored in many different formats, in a single 

file or as separate files. One of the most common storage formats is “side by 

side” (SbS) in which both the left and right images of the view are placed next 

to each other and stored as one image in a single file. The SbS format has two 

variants, “wall-eyed” and “cross-eyed.” In a wall-eyed SbS file the image 

intended for the left eye is on the left, in cross-eyed format it's on the right. The 

Fuji W1 camera uses a storage format with a file extension of “MPO”, in SPM 

the MPO format is treated as a wall-eyed SbS format. 

Note that in the process described here the source images are assumed to be 

already mounted. That is that the alignment between the left and right views 

has been previously adjusted and the “stereo window” has been set, either 

automatically or by hand, as per normal for digital stereo photographs. MPO 

files from the Fuji camera are automatically “mounted” in the camera. 

However, you can have the images “re-mounted” by SMP by simply 

“checking” the “Auto Alignment” option in SPM. 

Two template files to be used in the “Multi Conversion” dialog in SPM are 

supplied by Cyclopital3D in order to simplify the conversion process, which 

can be found on the root directory of either PMP unit. 

The template file named “SbS_To_C3DV_800.mcv” produces images that are 

800 pixels wide, the other one named SbS_To_C3DV_2400.mcv produces 

images that are 2400 pixels wide. Both templates also provide for “offsetting” 

the images to control centering and overall convergence. You can use either 

one, but the smaller images load faster and consume less memory. Larger 

images may look better when you zoom in on them using the zoom function on 

the Viewer. If you don't zoom in much it's better to use images that are 800 

pixels wide. 

 

Preparing the Images for the Viewer 

Preparing images for the Viewer is a two step process, first you create properly 

forma�ed temporary SbS files from your source MPO or SbS files using the 

“Multi-Conversion” dialog in SPM. Then you split the temporary files into 

their right and left components using SPM's "Lossless Jpeg Multi 

Conversion..." dialog. The resulting files get loaded onto the Viewer and the 

temporary files can be discarded. 

The dialog on the following page is the “Multi Conversion” dialog in SPM, use 

the “Restore File” button to load one of the template files supplied, this action 

will set most of the parameters in the dialog so all you have to do is set the 

input and output folders. 
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Step by step instructions for using SPM to create files ready to load onto 

the Viewer: 

1. Start SPM and open the “File->Multi Conversion...” dialog 

2. Use the “Restore(File)” 

button to load either 

SbS_To_C3DV_800.mcv 

or 

SbS_To_C3DV_2400.mcv 

(depending  on the output 

image size you desire). 

3. Set "Look in" to point to 

the source folder of SbS 

files you wish to process. 

4. Set "Output Folder" to a 

folder that will be used to 

store the SbS temporary 

files that will be created by 

this processing step. 

5. Press "Convert All Files" 

6. After the process completes, close the “Multi Conversion” dialog 

7. Next, execute the "Lossless Jpeg Multi Conversion..." dialog to separate the 

side by side temporary files 

created above into left and 

right files for the viewer. 

The only option selected 

should be “Decompose Side

-by- side image” as shown 

in the dialog to the right. 

The “Look in:” field should 

point to the directory that 

contains the temporary SbS 

files you created using the 

“Multi Conversion” dialog. 

The “Output folders” are 

where you will find the files 

that are ready to be 

transferred to the Viewer, 

set them to a convenient location (you can type new directory names into 

the fields, the new directories will be created when the process runs. 

8.  Press “Convert All Files” to create the files you will load onto the viewer. 

Load the left (_l) files on the Left PMP unit, and the right (_r) files on the 

Right PMP unit. (see “Loading Images into your Viewer” below)  

9. Delete the SbS temporary files created using the “Multi Conversion” dialog. 

Notes: 
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Advanced Image Preparation options: 

The check mark in the “Save Borders” option of the “Multi Conversion” dialog 

tells SPM to use the parameters set in the “Boarder” dialog when saving the 

SbS image. The option is used in this procedure to control the “centering” of 

the images on the PMP units, which sets the overall convergence of the scene. 

It can also be used to better center the right and left images as seen through 

each eyepiece for people that have very narrow (less than 58 mm) or very wide 

(greater than 72 mm) eye spacing (interocular). As most people fall within this 

range, modifying the value from its “default” is usually not necessary. 

If you do decide to modify the value you may consider creating multiple copies 

of your images on the viewer organized in separate directories for “Narrow”, 

“Normal”, and/or “Wide” eyed persons. 

The “offset from center” of each image is half the value set as the “L/R Space” 

parameter. This parameter is stored in the “Multi Conversion” template (.mcv) 

file so it is set properly when you “Restore(File)” to load the settings in this 

dialog (even though it's not shown in the dialog). For images 800 pixels wide 

the “default” offset is 40 pixels (20 pixels per side), for 2400 pixel wide 

images the “default” offset is 120 pixels (60 pixels per side). 

You can set the offset to something other than 40 (for 800 pixel wide images) 

or 120 (for 2400 pixel wide images). You can decrease the value of the offset 

to accommodate people with very narrow eyes, or increase it for people with 

very wide eyes.  

To do this, first load the appropriate .mcv file 

in the “Multi Conversion” dialog, then exit the 

dialog and use the “View->Border Options...” 

dialog from the main menu to show the 

“Border” dialog. 

Change the “L/R Space” value to the desired 

total offset. Then re-enter the “Multi 

Conversion” dialog and change the "Width" 

setting to the total image width (800 or 2400) 

minus half the new offset (half the “L/R 

Space”). Note, to change the border options 

you must have a stereo image loaded in SPM 

or the “View” menu option will be grayed out. 

Finally, save the new parameters in a new 

“template” by using the “Save” button in the 

“Multi Conversion” dialog. 

Note that everything in this “Border” dialog 

should be 0 except the L/R Space, which should be set to twice the distance 

each image will be shifted. 

Note also that you can just edit the .mcv file directly (with Notepad) to change 

the relevant parameters instead of using the rather complex process described 

above. 
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Loading Images into your Viewer 

Once you have appropriately formatted Left and Right image files you can 

load them into the Viewer from Windows computers using “Windows 

Explorer. Copy the left images of stereo pairs from your computer to the left 

PMP unit, and the right images to the PMP unit on the right (referenced 

looking into the lenses). 

For convenience, images may be organized hierarchically in a tree of folders. 

The image files are stored in memory on the PMP units, in either built in 

memory (Local Disk) or on optional microSD memory cards (External Disk).  

Each PMP unit must be loaded separately. If two memory cards are used, one 

must contain the left images and the other the right, and they must be inserted 

into their respective Left and Right PMP units. 

The structure of folders and files MUST be identical on both the left and right 

PMP units. Any folder that exists on the left PMP unit must have a compliment 

on the right PMP unit. Complimentary folders must contain the same number 

of files (and folders) with “similar” names. The complimentary files and 

folders must be named so that they sort alpha-numerically in the same 

sequence. One way to do this is to have all folders and files named identically 

on both the left and right PMP units, but this is not absolutely necessary. The 

characters may differ toward the end of a complimentary name pair, as long as 

they sort alpha-numerically in the same order on both PMP units. For instance, 

folders and files on the left PMP unit could have “_L” appended to the names, 

where and “_R” might be used on the right PMP unit. 

 

Using microSD Memory Cards 

Memory cards work just like internal memory in the PMP units; again you 

must make sure the file structures on the cards for the left and right units 

match, meaning that all files and folders sort alpha-numerically in the same 

sequence. To view images stored on microSD cards select the “External Disk” 

option under “Photo” in the main menu instead of “Local Disk”. With 

microSD cards the image storage capacity can be extended up to 64 GB total. 

 

For Apple Users 

There is no specialized support for converting images (splitting, mirroring and 

resizing) on a Mac or for transferring images from your Mac to the Viewer. 

We recommend using “Boot Camp” or another Windows emulator to run 

StereoPhoto Maker. Mac computers will recognize the PMP units and present 

their file systems as per normal so you can copy the left and right directory 

trees of images to the PMP units using “finder.” (not recommended) 
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Technical Notes 

The Viewsonic PMP units are of the LTPS variety, which have the smallest 

spacing between pixels of any LCD type available and the colors are rich and 

beautiful. The units are too complex to document all the features they support 

here, this manual documents only the functions you need to view 3D photos. 

 

Miscellaneous Display Functions 

• To set the background wallpaper. View the image you want to use as your 

background using the normal process for viewing images. Then press 

“M” (C9) on the control panel to see a list of options. “Set Wallpaper” is the 

last choice, use the “Down-Arrow” button (C6) on the Control Panel to 

highlight it and then press “M” again. Press the “Left-Arrow (C7) to exit the 

list of options. 

• Setting image transition format. You can setup different graphic effects for 

the transition from viewing one image to the next in the viewer. The 

“default” is a simple replacement, but you can do sweeps etc. instead. To 

change the transition type, first view any image, then press “M” (C9) to see a 

list of options, select “switch mode” and choose the transition you like. 

• Use of the Automatic Slide Show is not recommended because after a few 

minutes the two PMP units will fall out of Sync. This may be fixed in a 

future PMP firmware update, but for now the slide show function is 

basically not usable. 

• Zooming and Panning on images. You can zoom in and pan around on 

images while you are viewing them in 3D. Pressing the +Vol button (12) on 

the control panel zooms in, and pressing the -Vol button zooms out. While 

you are zoomed in the arrow buttons on the control panel can be used to pan 

around on the image. There are three zoom levels up to a maximum of 3X 

800x480 or 2400 x 1440 (which is recommended for zooming). 

Miscellaneous Functions on PMP units 

The PMP units are preset as follows: 

In the Settings menu, 

Language → English 

Auto Power Off (inactivity time before power off) → 15 min 

Screen Close (inactivity time before backlight turns off) → 1 min 

Brightness → Level 5 (maximum brightness) 
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Power Management and Charging 

IMPORTANT: The power switches (15 and 16) on the bottom of the PMP 

units MUST be in the ON position when charging. If the power switches are in 

the OFF position the PMP units will NOT charge. 

You must press both buttons (1 and 2) on the top of the PMP units for at least 

two seconds to turn the PMP units on.  

Your Viewer control panel (17) uses a 3V lithium battery, CR2025. The 

control panel is attached to the bottom of your Viewer with several sturdy 

pieces of Velcro and can be removed when a battery change is necessary. 

Your Viewer has built in batteries and can operate for up to 4 hours of 

continuous use on a single charge. Recharging of fully drained batteries can 

take up to 3 hours. A battery charge indicator is displayed in the upper left 

corner when the main menu is showing, they may be different for right and left 

so close one eye to see them separately. 

To charge you PMP units simply plug in your AC adapters and connect them 

to the PMP units (6 and 7). Each PMP unit has it's own battery and must be 

charged separately. 

There are two types of chargers available, one that plugs into the Power-In Port 

(6 and 7) and another that plugs into the USB port (8 and 9).  

When you plug the units in to charge they will turn on automatically. However, 

when charging is complete and you unplug the units they will stay on and may 

drain the batteries. Be sure to turn the units off after charging if you don’t 

intend to use them right away. 

 

Troubleshooting 

• Left/Right image synchronization errors. At some point the two PMP units 

may get “out of sync”. There are a few ways that this can happen, but the 

most common is when a button is accidentally pressed on one PMP unit 

that advances the picture on that unit, but not the other. There are a few 

ways to recover from a mis-synchronized condition: 

1. Press one of the arrow buttons on the top of the Viewer (3 or 4). One of 

the buttons advances to the next image on that side and the other goes 

back. Which one you need to press depends on which unit is “ahead” of 

the other. Try pressing one arrow and if that doesn't work, press the 

other arrow on the same unit twice. 

2. Another way to recover from mis-sync is to press the left arrow button 

(C7) on the control panel until both units are showing the main menu 

and then navigate back to where you were. 

3. Lastly you can turn both the units off (C1) and start over from power up. 
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Troubleshooting 

• Image folders out of sync in Photo->Local Disk menu. If you accidentally 

enter “Record” mode (microphone icon in the main menu) a folder on the 

“Local Disk” named “record” will be automatically created by the PMP 

unit. If this happens on one unit and not both the folders on the two PMP 

units will be “out of sync”, to remedy the situation simply delete the 

“record” folder. There are two ways to do this: 

1. Connect the PMP unit to your computer using USB (8 or 9) and delete 

the folder using Windows Explorer. 

2. Delete the folder by using the buttons on the PMP unit itself (not the 

control panel). To delete the folder first highlight it under Photo->Local 

Disk using the control panel. Then quickly press the top power button (1 

or 2) on the PMP unit that has the “record” folder highlighted. You will 

get a menu with the first option “delete” highlighted. Press the button on 

the opposite end of the same PMP unit twice (the button is not labeled 

on the case, but actually performs the “enter” or “select” function). The 

first press is to select the “delete” function, the second is to confirm the 

deletion. 

• If somehow a PMP unit gets set to a language other than English it can be 

set back to English using the icon that looks like a “globe” in the settings 

menu (gear icon). Choose the middle option for English. Unfortunately the 

only languages supported are Chinese, simplified Chinese, and English. 

 

Technical Support 

Your Viewer purchase comes with a lifetime of free technical support and 

firmware upgrades, and 90 days of hardware repair coverage, which 

commences on the shipping date. 

If you experience persistent technical problems after reading the 

troubleshooting recommendations in this manual and checking our website, 

http://www.cyclopital3d.com for additional troubleshooting information, you 

may send an email to kburgess@cyclopital3d.com for technical support. 

Support requests will normally be responded to in 24 hours. 

 

Viewer Specifications 

800 x 480 resolution (each eye) 

Fully coated achromatic lens 

Scratch resistant front surface mirrors 

Uses two Viewsonic VDP400 PMP units for image storage and display 

8GB of storage per PMP unit for a total of 16GB 

Size: 200mm x 120mm x 95mm (7.9” x 4.75” x 3.75”) 

Weight: 850 grams (1 lb 14 oz) 
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 Care and Maintenance 

Use the lens cleaning cloth that was provided with your Viewer, or a similar 

microfiber lint free cloth to clean lenses. Do not spray liquid directly onto the 

Viewer and avoid getting any moisture in any openings. 

If it becomes necessary to clean the LCDs on the PMP units, the mirrors, or 

the backside of the lenses you may gain access by removing the PMP units 

from the side. Simply loosen the two set screws that hold each one in place 

using the 0.050” Allen Wrench provided and pull the unit outward. Be careful 

not to scratch the front surface mirrors, they are coated for scratch resistance 

but are still somewhat vulnerable. Use the sterile, disposable cleaning cloths 

for internal cleaning. 

Product Warranty 

The Cyclopital3D Digital Hand Viewer includes with a 90-day warranty 

against manufacturing defects in material or workmanship. It is warranted for 

normal use; abuse of the product is not covered. If you drop it, it will break. 

The Viewsonic PMP units include a separate manufacturer warranty that is 

transferred to the owner of the Cyclopital3D Viewer. But, if a PMP unit 

should fail you may contact Cyclopital3D and we will attempt to provide 

technical support or possibly replace the unit for you. 

 

 

 

 

 

 

 

 

 

 

 

© 2009 Cyclopital3D, Incorporated. All rights reserved. 

Caution: this is a delicate precision product and should be treated with the 

same care given to any fine camera or lens. Do not apply excessive force 

to the focus mechanism or lens barrels. 


